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Altmel

SAM D10 Xplained Mini

USER GUIDE

Introduction

This user guide describes how to get started with the Atmel® ATSAMD10
Xplained Mini board. The ATSAMD10 Xplained Mini evaluation kit is a
hardware platform to evaluate the Atmel ATSAMD10 microcontroller. The
evaluation kit comes with a fully integrated debugger that provides seamless
integration with Atmel Studio 6.2 (and later version). The kit provides access
to the features of the ATSAMD10 enabling easy integration of the device in a
custom design.
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Getting Started

Features

The ATSAMD10 Xplained Mini evaluation board provides a development platform for the Atmel
ATSAMD10.

Key Features

*  On-board debugger with full source-level debugging support in Atmel Studio
*  Auto-ID for board identification in Atmel Studio

*  Access to all signals on target MCU

*  One green mEDBG status LED

*  One yellow user LED

*  One mechanical user push button

+  QTouch® user area

*  Virtual COM port (CDC)

*  8MHz external target clk

+  USB powered

«  3.3Vregulator

*  Arduino shield compatible foot prints

*  Target SPI bus header foot print

«  Xplained Pro extension headers can easily be strapped in

Design Documentation and Related Links

The most relevant documents and software for the evaluation board are available here:

Design Documentation - A .zip file containing CAD source, schematics, BOM, assembly drawings, 3D
plots, layer plots, etc.

Atmel Studio - Free Atmel IDE for development of C/C++ and assembler code for Atmel microcontrollers.
Xplained - Atmel Xplained prototyping and evaluation platform.

Atmel Spaces - Open Source projects for Xplained Mini.

Xplained Mini Quick Start

How to connect the ATSAMD10 Xplained Mini board embedded debugger to Atmel Studio and how to
connect the ATSAMD10 UART to a COM port.

Connect to Atmel Studio
How to connect the ATSAMD10 Xplained Mini board embedded debugger to Atmel Studio to get started
with SW development.

1. Download and install Atmel Studio version 6.2 or later versions.

2. Launch Atmel Studio.

3. Connect the board to the USB port and it will be visible in Atmel Studio.

AtmeL Atmel SAM D10 Xplained Mini [USER GUIDE] 3
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1.3.2. Connect to the COM Port
How to connect the ATSAMD10 UART to a COM port.

All Xplained Mini boards have an embedded debugger (MEBDG) with a number of features, among them

a CDC/COM port, which enables the user to connect the ATSAMD10 UART to the PC.
1. Connect the Xplained Mini USB to the PC.
2. A COM port named "mEDBG Virtual COM Port" will be available.

3. Start a terminal emulator or other applications using the COM port, typical COM port settings are
9600 baud N81.

1.4. Programming and Debugging
Programming and debugging the ATSAMD10 Xplained Mini.
The target microcontroller is the ATSAMD10.
The mEDBG FW is running on the ATmega32U4.

1.4.1. Programming the Target Using mEDBG
Using the Embedded Debugger on the ATSAMD10 Xplained Mini board to program the ATSAMD10.

1. Connect the Xplained Mini USB to the PC.

2.  Go to Atmel Studio: click the Tools tab, select Device Programming, and select the connected
mEDBG as Tool with Device as ATSAMD10 and Interface to SWD, click Apply.

3. Select "Memories" and locate the source .hex or .elf file and click Program.

mEDBG (ATML23 000) @ - Device Prc g a8 w B e [

' Tool Device Interface Device signature Target Voltage I

ATSAMDI0DI4AM + 010020100 33V (%3]

Interface settings Device

Tool i ‘Erasechlp 'H Erase now ‘

Device information Flash (16 KB)

Memories CAUsers\tbjoernvold\Documents\svi\ATSAMD10_Xplained_Min)\ATSAMD10-XMINNO7_Firmware\re ~ [ . |
v
Fuses Erase Flash before programming ‘ —— J ‘ T ‘ ‘ Read.. ‘
S 7] Verify Flash after programming
User Page (64 bytes)
[¥] Erase User Page before programming T‘
9] Verify User Page after programming | Reod.. ]

[~] Reading device ID..OK

1.4.2. Debugging the Target Using mEDBG

Using the Embedded Debugger on the ATSAMD10 Xplained Mini board to debug the ATSAMD10 via
SWD.

1. Start Atmel Studio.
2. Connect the Xplained Mini USB to the PC.
3. Open your project.

AtmeL Atmel SAM D10 Xplained Mini [USER GUIDE]
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5.
6.

Click the "Project" tab and select the project "properties", click the "Tools" tab and select mEDBG
as debugger and SWD as interface.

Click the "Debug" tab and select "Start Debugging and Break".
A debug session is started with a break in main, debugging can start.

1.4.3. Programming the Target Using an External Programmer
How to program the target ATSAMD10 using the Atmel-ICE or other Atmel Programmers.

1.
2.
3.

4.

Connect the External Programmer USB to the PC.

Connect the External Programmer to the ATSAMD10 Xplained Mini board SWD connector.

Go to Atmel Studio: Click the Tools tab, select Device Programming, and select the External
Programmer connected as Tool with Device as ATSAMD10 and Interface to SWD, click Apply.
Select "Memories" and locate the source .hex or .elf file and click Program.

1.4.4. Programming the ATmega32U4 Using an External Programmer

How to program the ATmega32U4 using the AVR JTAGICE mkll, JTAGICE3, Atmel-ICE, or other Atmel
Programmers.

1.
2.
3.

5.

Atmel

Connect the External Programmer USB to the PC.

Connect the External Programmer to the ATSAMD10 Xplained Mini board JTAG connector.
Go to Atmel Studio: click the Tools tab, select Device Programming, and select the connected
mEDBG as Tool with Device as ATmega32U4 and Interface to JTAG, click Apply.

Select "Memories" and locate the source .hex or .elf file and click Program.

Atmel-ICE (141800001190) @ - Device Programming .‘ P L!_J_ih =B

l Tool Device Interface Device signature Target Voltage

meseaun—~ [11a6—=] Aum] || = ~ [nes) (@

Interface settings Device

Tool i i | Erase Chip 'H Erase now ‘

Device information Flash (32 KB)
Oscillator Calibration Tmega328PB_Xplained_Mini\07_Firmw

shipment_fir dbg_images-2.0.038\medbghex v | .. |
Memories ¥| Erase device before programming
Fuses 7] Verify Flash after programming [ Progam | [ veiy | [ Resd. |

Lock bits EEPROM (1 KB)

L CAUsers\tbjoernvold\Documents\svn\ATSAMD10_Xplained_Min\ATSAMD10-XMINI\O7_Firmware\ ¥ ‘7‘
Production file L=

7] Verify EEPROM after programming | Progam | [ Veriy | [ Read.. |

-] ok

Select "Fuses" to program the fuses manually. Set the fuse(s) and click "Program”. Recommended
fuse settings:

Atmel SAM D10 Xplained Mini [USER GUIDE] 5
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1.4.5. Programming the ATmega32U4 Using a Bootloader
This section describes how to use the bootloader to program the ATmega32U4.
1. Install the Bootloader interface on the PC, download the installer from FLIP.
2. Start the Bootloader PC GUI "FLIP".
3. Short strap J102.
4. Connect the ATSAMD10 Xplained Mini board USB connector to the PC.
5. Select Device = ATmega32U4 (Device - Select).
6. Select USB communication (Ctrl+U).
7. Select memory area to program (use the toggle memory button bellow the Atmel logo).
8. Select Load Hex file (Ctrl+L).
9. Select Programming Options.
10. Click "Run", observe status in status field.
1.5. Board Assembly
The Xplained Mini board can easily be assembled into a product prototype for software development and
hardware verification.
1.5.1. Custom Assembly
All signals of the ATSAMD10 are available in the Xplained Mini board connector grid, enabling easy
connection of external sensors and output devices in order to prototype the customer specific application.
1.5.2. Standalone Node
The ATSAMD10 Xplained Mini board can be used as a standalone node with an external power source,
e.g. the 4xAAA or 2xAAA battery pack available from Atmel.
1.5.3.  Connecting an Arduino Shield
Arduino® shields can be mounted in the marked positions (J200, J201, J202, and J203).
AtmeL Atmel SAM D10 Xplained Mini [USER GUIDE] 6
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l Tool Device Interface Device signature Target Voltage U

simegwas - 145+ semy] | oaesr sov. [ses) [

Interface settings Fuse Name Value
Tool information @ BODLEVEL [2v0 ~
¥ HWBE 7

Device information
() OCDEN

@ITAGEN @

@ sPieN v

@ woToN

@ eesave 5%

Production file @ sooTSz 2048W_3800 |

@ BOOTRST

@ cxoive v

@ cxout v

() SUT_CKSEL | EXTXOSC_8MHZ_XX_258CK_65MS ~

Oscillator Calibration
Memories

Fuses

Lock bits

Fuse Register  Value
EXTENDED  OxF6

HIGH 0x91
Low Ox1E

Copy to clipboard
V| Auto read ‘M‘
7] Verify after programming [ Program |( Verity |[ Read |

E] Read registers..OK
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mEDBG Command Line Interface
The mEDBG has a command line interface enabling configuration of the mEDBG.

mEDBG Low Power Modes
There are two modes enabling the Xplained Mini to save power when connected to an external power
source other than an USB connection.

Sleep Mode where the mEDBG is disabled. When enabled the ATmega32U4 will enter sleep mode if not
enumerated within about 5sec. In this mode the external clock is not available to the target MCU.

1MHz Mode where the mEDBG/ATmega32U4 is set to run at 1MHz, saving power while maintaining the
USB connection for the COM port. The external clock will be 1MHz.

Table 1-1 Available Commands

m External CLK | COM port SWD program SWD debug

Sleep OxFB (bit2=0) | disabled disabled disabled disabled
1MHz OxFD (bit1=0) 1MHz enabled useless useless
Factory settings | OxFF 8MHz enabled enabled enabled

How to Issue Commands
The command line interface is supported by mEDBG version 1.6 or later.

The mEDBG command line interface can be accessed with the Python® script found on Atmel Spaces
Releases (mMEDBG_script.zip).

If you have Studio 7.0 (and later versions), the mEDBG included supports the command line interface, if
not, the mEDBG can be downloaded from Atmel Spaces Releases (medbg_fw.zip).

Basic Python is required to run the script, Python can be downloaded from Python.
How to Issue Commands

Install Python.

Download the file "mEDBG_script.zip" from Atmel Spaces Releases.
Unzip the file "mEDBG_script.zip".

Edit "stuff.py" to issue the selected command "c.set_suffer(0xXX)".

Open a command window in the directory where "stuff.py" is located. (Browse to the, folder right-
click on folder with shift pressed and select “Open command window here”.)

Connect the Xplained Mini.

Run "stuff.py" (c:\Python27\python stuff.py).

The script will print the selected tool and display SUFFER setting.

Recycle power (disconnect/connect the board) for the change to take effect.

0. Edit "stuff.py" to issue the command c.set_suffer(0xFF) to reset to factory setting.

a kw0

—“°9°.\‘.°’
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r B
B CA\Windowshsystem3Ziomd exe l | = | = |-'€“’;_|

CisllzerssthjoernvoldsDocumentssmEDBG_script o isPuthon2™python stuff . py
CHSI15-DAF DLL loaded
CHSIS-DAP tools detected: 1
Tool B>
Serial number: ATHML252361 82000000683
Uendor: Atmel
Product: mEDBG CHSIS-DAP
Device: Atmel ATmegad28PB
Packet size: 64

elected mEDBG {ATHL2523818280060606883 >
Connected
tarting session...
SUFFER reads as: BxFB
SUFFER reads as: @BxFF
Ending session...

CHMSIS DLL freed

CisllzerssthjoernuoldsDocumentssmEDBG_script >

il T b

How to Upgrade the Xplained Mini mEDBG

Start Atmel Studio.
Connect the Xplained Mini to the computer.
In Atmel Studio, select Tools — Device programming (Ctrl — Shift — P).

In the Device Programming window, select Tool to mEDBG and click Apply. If there is a new
mEDBG version available, the Atmel Studio will ask if you want to upgrade.

5. To verify mEDBG version, click "Tool Information" when mEDBG is selected as Tool.
r

Poobd=

mEDBG (ATML2523010200000003) @ - Device Programming

" Tool Device Interface Device signature Target Vol

|mEDBG ~ | ATmega328PB =~ [ISP = || &pply| — | Read |
Interface settings mEDEG
Tool information i Debug host
Cevice information Fichug o

| ]

l Gsdillator Calibaation Senial number ATML2523010200000003
7 I Connection com.atmel.avrdbg.connection.cmsis-dap
Fhicic Firmware Version la
e Hardware Version 0
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2,

2.1.

2.2.

2.21.

Hardware User Guide

Board Overview
The ATSAMD10 Xplained Mini headers overview.

J301, Target power

J300, Power source J100, JTAG

J104, COM

J102, BOOT strap J200, Digital I/O high
mEDBG LED

External Clock
J202, power I/O

J203, analogue I/O
J204, SPI

User button

User LED

J201, Digital 1/0 low

J205, SWD

Target Headers and Connectors
The ATSAMD10 related headers.

Target Digital 1/0
The J200 and J201 headers provide access to the ATSAMD10 digital I/O pins.

Table 2-1 J200 Digital /0 High Byte Header

J200 ATSAMD10 pin
pin
1 NC D8

2 NC D9

3 PA23 D10 SS, SPI Bus Master Slave select, SERCOM1 or TCCO0/
WOI5]

4 PA22 D11 MOSI, SPI Bus Master Output/Slave Input, SERCOM1 or
TCCO/WO[4]

5 PA24 D12 MISO, SPI Bus Master Input/Slave Output, SERCOM1 or
TCCO/WOQOJ2]

6 PAO9 D13 SCK, SPI Bus Master clock Input, SERCOM1, User LED

7 GND

AtmeL Atmel SAM D10 Xplained Mini [USER GUIDE]
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PA03 AREF
9 PA14 SDA, 2-wire Serial Bus Data Input/Output Line.
SERCOM2
10 PA15 SCL, 2-wire Serial Bus Clock Line. SERCOM2

Table 2-2 J201 Digital /0 High Low Header

PA11 TXD (ATSAMD10 USART Output Pin), SERCOMO
2 PA10 D1 RXD (ATSAMD10 USART Input Pin), SERCOMO
3 PA16 D2
4 PA17 D3 PWM TCCO/WOI7]
5 PA27 D4
6 PA25 D5 PWM TCC1/WQI[5]
7 PA30 D6 PWM TC2/WO[0]
8 PA31 D7

2.2.2. Board Power Header
The J202 header enables connection to the ATSAMD10 Xplained Mini power system.

Table 2-3 J202 Power Header

1 NC

2 VCC_TARGET The power source selected for the target. (Select by J301)

3 RESET_SENSE | This is a RESET signal monitored by the mEDBG. If pulled low the
target RESET line will be pulled low by the mEDBG. The ATmega32U4
internal pull-up is enabled. This signal is not available during debugging.

4 VCC_P3V3 The 3.3V regulator output

5 VCC_P5V0 The selected power source. (VIN or VBUS selected by J300)

6 GND

7 GND

8 VCC_VIN The external power source connection.

2.2.3. Target Analogue I/O
The ATSAMD10 ADC input pins are available in the J203 header.

AREEF is available in J200 pin 8.

AtmeL Atmel SAM D10 Xplained Mini [USER GUIDE] 10
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Table 2-4 J203 Analogue Header

1 PAO2 ADC Input Channel 0
2 PAO3 ADC Input Channel 1
3 PAO4 ADC Input Channel 2
4 PAO5 ADC Input Channel 3
5 PAO6 ADC Input Channel 4
6 PAQO7 ADC Input Channel 5

2.2.4. Target SPI Header
The SPI bus is available in J204, the SPI header.

Table 2-5 SPI Header

1 PA24 MISO

2 VCC target
3 PA09 SCK

4 PA22 MOSI

5 PA28 RESET

6 GND

2.2,5. Target Programming

The J205 SWD header enable direct connection to the SWD bus with an external programmer for
programming of the ATSAMD10.

2.3. Target GUI
The ATSAMD10 Xplained Mini user GUI consist of one LED, one push button, and a QTouch button.

QTouch button (QT200)

Push button (SW200)

a
®
<
9
<
<
a
(7]
<
a.
©
<<
@
~
<
a

User LED (D200)

2.3.1. Push Button
A general purpose push button, SW200, is connected to PA25.

AtmeL Atmel SAM D10 Xplained Mini [USER GUIDE] 1
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USER BUTTON

VCC_TARGET

R201

SW200

SKRAAKEO010
™ o~y 3
J L4

al
2

——C204
100n

2.3.2. User LED

There is one yellow LED, D200, available for use by the application SW.
The LED is connected to ATSAMD10 PAQ9/SPI_SCK, also available in the SPI header and the J200

header.

USER LED

D200
LED_ 12
\\:EL 17-21UYC/A3

2.3.3. QTouch Button

There is one QTouch button connected to PA07 (Y[5]) via 100kQ.

Atmel
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QTOUCH BUTTON

QT200

Lolbe PAO7

1

QTouch Button

24, On-board Power Supply

The ATSAMD10 Xplained Mini board has an on-board 3.3V regulator (150mA) which can be used to
power the ATSAMD10.

The J300 and J301 headers configure the ATSAMD10 power supply and the board power source.

The default configuration is set by R300 and R302 0Q) resistors which can be easily removed to change
the default configuration.

Table 2-6 Board Power Options

J301 connection, J300 connection,
target board

VIN/VBUS | pin2 connected to pin1 | pin2 connected to pin1 | Target powered by VIN, USB interface

remove R302 and 3.3V supply powered by VBUS
3.3V USB  pin2 connected to pin3 pin2 connected to pin1 Target powered by 3.3V, USB interface
(Default) and 3.3V supply powered by VBUS
VIN pin2 connected to pin2 connected to pin3, Board and target powered by VIN

pin1, remove R302 remove R300 (J202.8), 1.7V < VIN < 3.5V. 3.3V

regulator disabled

3.3V VIN pin2 connected to pin3 | pin2 connected to pin3, Target powered by 3.3V. VIN (J202.8)
remove R300 as 3.3V regulator input. 4V < VIN < 16V

For the CPU to successfully decode and execute instructions, the supplied voltage must always

Tip: Use the BOD LEVEL fuse to avoid the following challenges:
*_
stay above the minimum voltage level set by the chosen operating frequency.

When supplied voltage drops below this level, the CPU may start to execute some instructions
incorrectly. The result is unexpected activity on the internal data and control lines.

This activity may cause CPU Registers, I/O Registers, and Data Memories to get corrupted.

To avoid these problems, the CPU should be prevented from executing code during periods of
insufficient supply voltage.

AtmeL Atmel SAM D10 Xplained Mini [USER GUIDE] 13
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2.5.

2.51.

2.5.2,

2.5.3.

2.5.4.

mEDBG

The ATSAMD10 Xplained Mini board has an embedded debugger/programmer enabling debugging and
programming of the ATSAMD10 without any additional external equipment.

mEDBG Status LED
The mEDBG has a green status LED connected to ATmega32U4 PC6 to signal the embedded debugger
state.

Table 2-7 mEDBG Green Status LED Function

Enumeration ON During the initial USB connection process the LED is on until enumerated
or if not enumerated it is turned off within about 5 seconds

Programming ON The LED is active during programming

Debugging ON The LED is active when the debugger is running

mEDBG External Clock
The mEDBG (ATmega32U4) clock out signal (PC7) is connected to the ATSAMD10

XOSC XIN signal (PA08). It can e.g. be used as an accurate clock source for XOSC or XOSC32K. The
External Clock frequency is 8MHz.

Tip: The External Clock can be set to 1MHz to save power using the mEDBG command line
interface.

Tip: There is a test point marked EXT.CLK enabling easy measuring and/or connection to the
CLK signal.

mEDBG COM Port Connection
The mEDBG provide a CDC COM port connection when connected to a USB host device.

The mEDBG (ATmega32U4) USART is used for communication with the CDC COM port. The USART
TX/RX signals are available on the J104 header and are also connected to the ATSAMD10 via 0Q
resistors enabling easy disconnect from the ATSAMD10 if needed.

Table 2-8 J104 USART Header
siotpn  ATmegaszus ATSAMDIO —Functon
1-USART TxD PD3 PA11/RxD TxD out from ATmega32U4

2 - USART RxD PD2 PA10/TxD RxD in to ATmega32U4

mEDBG JTAG Interface
The mEDBG (ATmega32U4) JTAG interface is available for programming and debugging of the
ATmega32U4.

AtmeL Atmel SAM D10 Xplained Mini [USER GUIDE] 14
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Table 2-9 J100 JTAG Header

1 TCK
2 GND
3 TDO
4 VCC_BOARD ATmega32U4 Ve
5 TMS
6 RESET Connected to ATmega32U4 only
7 NC
8 NC
9 TDI
10 GND
2.5.5. mEDBG USB Interface
J101 is a Micro-B USB connector connected to the embedded debugger (ATmega32U4).
Table 2-10 J101 USB Header
1 VBUS
2 D-
3 D+
4 NC
5 GND
The VBUS has a resettable PTC fuse (F100), with a hold current of 0.5A and a trip current of 1.0A to
protect the USB host device.
2.6. Extension Header Area
The marked area on the grid 17 to R8 can be used for strapping in an Xplained Pro extension header or a
10-pin Xplained/RZ600 header.
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SPI_SS
SPI_MISO

Extension h
)

eader area

The SPI bus signals are made available close to the header at row J and K, enabling easy connection to

header pin 15 to 18.

Using Pin 11 to 20 enables connection of the 10-pin connector used on the RZ600 wireless modules and
the 10-pin Xplained sensor modules.

The general bus connections for an Xplained PRO Extension board is indicated in the table below,
detailed wiring can be found in the selected extension board documentation.

Table 2-11 Extension Header Typical Signals

1

© 0 N O o b W0 DN

-
o

1
12
13
14
15
16
17

Atmel

ID
GND
ADC(+)
ADC(-)
GPIO1
GPIO2
PWM(+)
PWM(-)
IRQ/GPIO

SPI_SS_B/
GPIO

12C_SDA
12C_SCL

UART_RX
UART_TX
SPI_SS_A
SPI_MOSI
SPI_MISO

Communication line to the ID chip on the Xplained extension board
Ground

Analog to digital converter, alternatively positive part of differential ADC
Analog to digital converter, alternatively negative part of differential ADC
General purpose I/0

General purpose I/0

Pulse width modulation, alternatively positive part of differential PWM
Pulse width modulation, alternatively negative part of differential PWM
Interrupt request line and/or general purpose 1/0

Slave B select for SPI and/or general purpose /O

Data line for I12C interface

Clock line for 12C interface

Receiver line of ATSAMD10 USART

Transmitter line of ATSAMD10 USART

Slave A select for SPI

Master out slave in line of serial peripheral interface

Master in slave out line of serial peripheral interface

Atmel SAM D10 Xplained Mini [USER GUIDE]
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Pin |Signal name Signal description

18 SPI_SCK Clock for serial peripheral interface
19 GND Ground
20 VCC Power for extension board

2.7. Factory Programmed
The ATSAMD10 is preprogrammed with a demo program, ReMorse.

When the CDC COM port is connected to a terminal window (9600 N81), the text you write will be
transmitted via the LED in Morse code. Any Morse code transmitted by using the switch will be displayed
as text in the terminal window.

The ATmega32U4 is preprogrammed with the mEDBG.

Atmel
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3. Document Revision History

Table 3-1 Document Revision History

42387B 08/2015 Slightly updated
42387A 02/2015 Initial document release
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